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1. Introduction 
SipText is a Windows application developed to manipulate text in SCORE music files. In addition to the 
SCORE text features, there are advanced capabilities which make working with text easier and faster than 
in SCORE itself. While the use of this utility is intuitive, full benefit will be drawn from reading the user 
guide. 
The program comes in a basic version with two optional extensions. The separately priced extensions are 
support for kerning and for Cyrillic. 
The reader is assumed to be familiar with SCORE and its parameter structure. 

2. Advantages 
There are numerous valid arguments for using the text editor: 
� Simple to learn – all functions are menu driven, require only a minimum of keys or mouse clicks while 

colors are used to distinguish the different items and their status on the screen. 
� Copy and paste – copy text between SCORE music files and other Windows applications. 
� Speed – walk through a series of files with one click, move text items by drag and drop. 
� Proper visualization of typical SCORE combination characters – on the screen you see the real graphics 

for characters such as á, æ, ã for <<a, ?a, ~a, etc. as well as for octal representations. 
� Visualization of special SCORE characters which do not have a Windows equivalent graphic. 
� Width computation using Adobe Font Metrics (AFM) or PSC – used in centering, flushing and lyrics. 
� Width computation of octal characters – used in centering, flushing and lyrics. 
� Powerful lyrics entry and edit – assigning syllables to notes, alignment, centering, handling of dashes 

and extenders. 
� Screen addressing – select items from the screen. See the parameters of a text item by just moving the 

mouse over it. 
� Font selection – names of fonts are presented for numeric SCORE fonts. 
� Profile setting – adapt the application to your project or your specific preferences. 
� Status information and on-line explanation – most screen objects have tooltips, view crucial 

environment settings, on-line help. 
� Graphical keyboard – in addition to the physical keyboard use the screen keyboard for uncommon 

characters. 
� Alignment and centering of page numbers. 
� Keyboard diad translation. 
 
For kerning, the advantage really is that there is no alternative other than mixing SCORE’s music output 
with the features of publishing software. Kerning is combined with centering and justification. 
 
For Cyrillic, the advantages are: 
� See on the screen what will be in the music file. SCORE has no alternative for this. 
� Support for several keyboard layouts and fonts. 
� Copy and paste with Russian word processors. 
� Automatic font change within a text when the ScoreCyr font does not have a specific character to a font 

which does. 

3. Environment 
SipText runs as a Windows application under the main SIP program. During the installation process of SIP, 
the necessary links are established to the environment used between SCORE and SIP utilities. It uses some 
of the global settings from this main program and refers to specific external sources from the SCORE and 
Windows environment. The environmental sources are herewith described. 
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3.1. Hardware requirements 
The development system used is 1.5 GHz and convenient for working with SipText. The machine used for 
product qualification is 1996 vintage with GenuineIntel Pentium of which the speed is 66.6Mhz. It has not 
enough steam for SipText in a production environment. The following functions require current day 
technology: 
� advanced file selection when your system has many folders and files; 
� reading and writing SCORE files; 
� graphic display of a SCORE file. 
For screen requirements see paragraph 3.4.2. 

3.2. Score environment 
SipText needs SCORE information specific for the handling of text. This information does not require any 
special preparation but it needs to be present on the same system. Note that to view a SCORE file by 
SCORE there is just one click to give control to that application. SipText will not work if SCORE is not 
installed on the same system. SipText refers to: 
� PREF.SCR – from which it picks up the dash size. If not defined it assumes the value 1.29. 
� PSC files – from which it picks up the available fonts, the font names and their character sizes. 
� FONTINIT.PSC – from which it picks up the current Postscript information. 
� AFM files – optional, to get correct and complete character size information. Required for kerning. 
 
The settings are kept in two ‘registry’ files:  
� Systems settings – these are kept in SIPCNTRL.INI which is created at SIP installation time and 

maintained by SIP itself. The user can view this file by double-clicking the Beethoven picture on the 
main panel. In the file, SIP keeps the paths to the SCORE environment and Windows entities. 

� Global settings – these are initialized the first time SIP is called and maintained by the user via the 
button ‘Set project options’. To see the file SIPPROJ.PRO which keeps these settings, push the small 
button on the right. Note that you can also view and maintain PREF.SCR from this panel. 

3.3. Global SIP settings 
The common program for all SIP utilities defines a number of settings of which some are passed to 
SipText. These are: 
� Initial folder for file selection – this speeds up file selection within one project. 
� Preferred filename extension of SCORE files – usually MUS or PAG. 
� Page number placement – this allows centering/alignment of page numbers by clicking on them. 
� Page number font and size – page numbers are shown on the screen but they must be recognizable as 

such. 
� Bar number font and size – bar numbers are shown on the screen but they must be recognizable as such. 
� Lyrics text size – used to distinguish potential lyrics text from other text. Note that the font in this panel 

is not used by SipText. 

3.4. Windows settings 

3.4.1. Fonts 
The user needs Windows fonts for visualization. Some fonts are mandatory and some are optional. The 
presence of these fonts is checked dynamically but only the most common ones present in all Windows 
systems are used by SipText. Installation instructions provide details on required and optional fonts for the 
Cyrillic extension. 
When the user has specified AFM files for character width computation, these files have preference over 
PSC files individually. The PSC files are still necessary since they link the SCORE font number to the font 
name. 

3.4.2. Screen size 
The screen size is dynamically checked at program start. It must be at least 800 x 600 for SipText to be able 
to work while bigger sizes are suggested. Best results are currently obtained with a screen size of 1400 x 
1050. To find out the size of your screen, use Help > Environment. 
Installation on a system with a 1024 x 768 screen showed that this screen size is still comfortable for 
working with SipText, but smaller sizes are not. SipText uses the entire vertical workspace excluding the 
task bar. When the View > Full Text control frame is set, the entire screen width is used. 
To make more space vertically, you can  
� hide the taskbar or put the taskbar vertically on the right; 
� work with View > Full Text control frame off. 
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4. The graphical user interface 
The panel which interfaces with the user has a menu line and three frames: File control, Page control, and 
Text control. At program start, File control is visible. Once files are selected, the other frames become 
visible. The Text control frame can be temporarily made invisible during functions which do not allow 
simultaneous keyboard input. 

4.1. Menu line 
The title bar and menu line are shown here: 
 

 
 
The title bar gives the version and build number. Individual menu titles can be disabled if they are 
momentarily not allowed. The various menu options have submenus described here: 

4.1.1. File 
Initialize profile – erases the user profile and terminates the program. At subsequent program start, a default 
profile will be newly created. 
Save – saves the file currently being processed. 
Save as … – saves the file currently being processed under a selectable name and path. Only the short type 
filename (8.3 format) is allowed. 
Save and exit – saves the file currently being processed and terminates the program. 
Exit – terminate the program. 
Note that the termination button in the title bar (or Alt+F4 shortcut) will give the option to save the file 
currently being processed if any changes were made to it. 

4.1.2. Edit 
Copy – the text in the input buffer is copied to the clipboard. 
Paste – the text in the clipboard is copied to the input buffer. 
Paste Cyrillic – the Cyrillic text in the clipboard is copied to the input buffer. 
Horizontal step – value used when text items are moved. Par3 will be set to the nearest multiple of this 
value. 
Vertical step – value used when text items are moved. Par4 will be set to the nearest multiple of this value. 
Center value – position used for centering text. Initially 100. 
Left flush value – position used for flushing text to the left. Initially 0. 
Right flush value – position used for flushing text to the right. Initially 200. 

4.1.3. View 
Profile – views the profile setting for SipText. Though discouraged, you can make changes to this file. 
When the viewer is closed, SipText terminates so that when restarted, any changes will be effective. 
To left corner – the panel can be moved across the screen. When this option is selected, it will be positioned 
in the top left corner. 
Windows fonts – provide a table of all Windows fonts on the system in alphabetical order. Close this list by 
a single click on it. 
Uppercase keys as bold – in the Text control as keyboard is drawn. When ‘Caps lock’ is selected, 
uppercase keys will appear with a bold font. 
Full Text control frame – the Text control frame comes in two sizes. Screens wider than 800 can show part 
or all of the full size frame which has additional non-pertinent information to be described later. 
Big tooltip – when the display size is hard to read, an enlarged tooltip will momentarily appear on top of the 
panel. This tip disappears when the cursor enters the white background. A checkmark is set when the option 
is in effect. 
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4.1.4. Keyboard 
The submenu lists all supported keyboards. Yet unsupported keyboards appear disabled. When the program 
is started, the ‘English US’ keyboard is selected. 

4.1.5. Screen 
Autosize – text appears on the screen with a green background. The background gives the proportional 
width in SCORE when this option is off. The height of the green band is not proportional. When the text is 
longer than can be contained on this background, the user can select a smaller display font or ask SipText to 
make the background as long as the displayed text with Autosize. A check mark indicates that the option is 
in effect. 
Ruler – A simple ruler is shown in the displayed page. This ruler can be suppressed to make more space for 
display by resetting this option. The ruler can also be suppressed by clicking on it. 
Refresh – The displayed page is drawn again. This is useful if you have added text above the top staff and 
want to see the new layout adjusted to the top, or to view the display text in another font. Note that the 
refresh function does not reread the file. 

4.1.6. Lyrics 
Align lyrics – Attach syllables to the nearest note. Par3 will be set to that of the note. A displacement is 
prompted which becomes the offset in Par11 (default is zero). 
Center lyrics – Attach syllables to the nearest note. Par3 will be set to that of the note. The offset is moved 
to Par11. 
Center dashes – All dashes are put in the middle of the syllables they connect. If there is no note on the 
right it assumes the end of the staff as beginning of a syllable. If there is no note on the left, it assumes a 
distance set by an option. 
Align extenders – Extenders are aligned to the syllable on the left and to the nearest note on the right. When 
there is no note on the right it assumes a distance from the end of the staff. Options control distances. 

4.1.7. Options 
Outline font – by default the current font prefix has one underscore. Set this option to select the outline font 
indicated by two underscores. 
Setup – shows an additional options panel for the setting of keyboard preferences, global lyrics definitions,  
display fonts, editor options and kerning. The close button saves the options in the profile and brings you 
back to the main SipText frame. The Options are shown here: 
 

 
 
The above options panel has the status of SipText with the Kerning and the Cyrillic extension. Without 
these extensions, the particular options are disabled. 
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The text for most options is self-explanatory while some texts and fields have additional tooltips. 

Keyboard preferences 
English UK 47 refers to a keyboard with 47 character keys etc. Keyboard layouts are described in the Text 
control chapter. Here you select a preferred keyboard for your application. When you select a text, the 
keyboard will automatically be set to the one indicated for that script. 
The button ‘Keyboard diads’ is explained separately – see 4.4.4 

TimeScore preference 
The TimeScore family of fonts has two ways to represent Cyrillic � and � in SCORE. On input, both 
formats are recognized. On output, the preference is generated. 

Allow underscore as character 
The underscore is reserved in SCORE for font prefix. When a text has an underscore without a font number 
following, then SCORE gives the error message  

      ‘*** ERROR number missing after underbar ***’ 
so by default the underscore is suppressed. The user can force the underscore as a text character by setting 
this switch. It is anyway suggested to use the octal character 137 when an underscore is required as text. 

Allow Latin characters in Cyrillic 
A Cyrillic font may not have a particular character. To let SipText automatically change within a text to a 
font which does have that character, set this option. The program will automatically revert to the Cyrillic 
font and never make adjacent prefixes or terminate an item with a prefix. 

Ampersand replacement 
Windows is hostile to the ampersand (&) character in the input buffer. If you need to type it, a replacement 
character needs to be defined. Depending on the script you are using, there is a number of possibilities to 
select from. Selection of a replacement character annuls the replacing character. 
Using the octal representation of the ampersand (046) avoids the hassle. 

Lyrics settings 
Tooltips explain the meaning of these fields. Note that some are SCORE defaults and should be handled 
with care when different. 

On-screen text options 
Choose different fonts for screen display. While the advantage of a narrow font is that display text fits in 
the green background which is the proportional text size (when Autosize is off), the drawback is that it is 
hard to read. Select the font which best fits your purpose. With close vertical text, the Small Fonts is 
suggested for Latin script because the green background is vertically smaller than for the others. 
In the On-screen text options, a checkbox is added which can be set to avoid the message which at startup 
tells you that optional Windows fonts are missing. 
In this panel there is also the definition for a separator character. This is used by the ‘Split’ command. 

Kerning 
The panel is activated when the kerning extension is installed. There are three selections which are tested 
when kerning is performed on a set of selected files. These options are not effective when kerning 
individual items (current item). 
Left aligned – Every text item is kerned while the original leftmost position of the text is maintained.  
Center aligned – Every text item is kerned and new position of the text item is set such that the middle of 
the original text item is maintained. 
Setting aligned – Every text item is checked against the right alignment value (default 200). If the right end 
coincides with that value, the item is kerned with that right end. When the end does not coincide, it kerns to 
the original left end. 
An option is foreseen to tell SipText to ignore specific text items for kerning. See the Kern on/off option as 
described in chapter 7.7. 
 
Page number on side displacement 
Clicking on a page number will align the number according to the project SIP setting. When the project 
setting is to center, the number will be centered to the center value (see 4.1.2). When the project setting is 
to side, even numbers will be put left, odd numbers right. Side alignment is controlled by the flush values 
and a constant defined in this displacement field. For example, the page number 123 will right align to 
position 196 if the right flush value is 200 and the displacement is 4.  
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The numeric value is interpreted as a string for width computation. Code10Par7 is interpreted as Times-
Roman Italic when 1. Fonts defined in Par7 as 1000 till 1089 are properly interpreted while any other value 
defaults to Times-Roman. 

4.1.8. Kerning  
The kerning submenu is explained in chapter 7. 

4.1.9. Help  
Narrative – shows the help file contents which is approximately identical to the User Guide text without the 
illustrations. 
Color codes – there are two panels explaining the color codes – one for the Page control frame and one for 
the Text control frame. Press on either close button to make the panels disappear. 
Environment – the pertinent environmental information is provided in a message box, an example follows: 
 

 
 
License – this provides a message box with the license and installed extensions. 
About – a message box is shown about authorship, acknowledgements, and trademark information. The 
Help > About mentions two fonts (Lazurski, Leed Courier) which are currently not supported. 

4.2. File Control 
This control panel is always visible. An example is shown here: 
 

 
This area may momentarily be overcast with an enlarged tooltip when pointing to a text item while the 
option Big tooltip is set. 

4.2.1. Select file(s) 
SCORE files are selected via this button. You can select one or more files in different ways as indicated by 
the submenu. The various methods have different advantages or disadvantages and depend on the speed of 
your computer, of the number of folders on your system, on the Windows configuration, etc. 
An attempt is made to provide a range of selection capabilities for all situations. When the preferred folder 
and file suffix were defined as project options, the selection is fastest. 
The names of the selected files are put in file NAMES.SIP which has the format known by SCORE users. 
Note that there is no restriction in path name length or the use of long file names as there is in DOS. 

4.2.2. View names 
To see the contents of the names file press button ‘View names’. Manipulation of this file is possible at the 
user’s own risk. When a selection was made, and the selected files were removed or renamed, this names 
file refers to non-existing files and a warning is given before forcing the user to make a new selection. 
This button has a tooltip which gives the number of files selected and the full path of the first name of the 
selection. When no files are selected, the button is disabled. 



 8 

4.2.3. Filename field 
The current file name is shown here without the path prefix. To obtain full details on the file, click this 
field. Shown are full path, size, date and time stamp, number of items, number of text items, and all the 
fonts (number and names) encountered in the file as well as the last save timestamp. Close the panel to 
continue. 

4.2.4. Progress bar 
Depending on your computer’s speed, reading a SCORE file takes more or less time as indicated by the 
progress bar. Note that SipText also needs time for sorting the input and drawing it in the Page control 
frame. The keyboard is invisible during this time as it cannot be used. 
Click the bar to see FONTINIT.PSC. After this view, SipText is terminated because the user might have 
updated it and the changes will influence the next program execution. 

4.2.5. Score 
This button calls SCORE. When there is a current file, this file is opened. When the user made updates with 
SipText, the file is saved before showing it with SCORE. On exit, the current file will be reread by SipText 
as to make any changes effective. 

4.2.6. First, Prev, Next, Last 
Walk through the file selection with these positioning buttons. Only those buttons are enabled which are 
applicable, meaning that when you selected one file only, there is nothing to walk through and all buttons 
are disabled. 

4.2.7. Goto 
When more than one file is selected, you can immediately position to any of these files via a list.  

4.2.8. New 
This button is enabled if no files were selected. To force this situation, press Select file(s), then cancel the 
selection. When New is enabled and pushed, an empty file with a desired number of staves is generated for 
training purposes.  

4.3. Page Control 
Visualization and item manipulation of a SCORE file is in this frame.  

4.3.1. Vertical positioning 
This frame is vertically adjusted to the available screen size between the File control frame and the Text 
control frame. For present day screens of 1400 x 1050, the frame is big enough to show an average SCORE 
file. 
The top has buttons to vertically control the visible window when a music file is too small to be shown 
entirely: 
 

 
 
The Distance button is always visible, the other buttons are only visible when a page is vertically beyond 
the vertical display size. 

Show other staff as highest 
Move the window up such that another staff becomes the top. Contrary to SCORE, SipText fills the display 
window from the top down, the highest text item just under the ruler. When the top staff has no text items 
or a page number, the staff is just under the ruler. 

Show staff […] as highest 
When there are non-displayed staves because the display is vertically insufficient, SipText suggests which 
staff could be the one to show as highest. 

Distance 
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The distance between shown staves is always fixed, independent on the SCORE staff distance (Code8Par4 
or Code8Par10). This distance can be differently set to get more staves on the frame, or to get more space 
between staves to show lyrics. Staves are shown as yellow bands of a certain height but when the distance 
is minimal, the height of the band is reduced. The height of the band is not proportional to the staff size. 
Move the mouse over a staff to see size, instrument, and to see if Par7 indicates invisible. 

Show top 
This button is not shown in the above example. To return to the top portion of a display, press this button. 

4.3.2. Ruler 
A ruler is optionally shown with intervals of ten SCORE positions. Press the ruler or use the Screen > Ruler 
menu to suppress or recall it. With a suppressed ruler there is more vertical space for the SCORE file 
display. 

4.3.3. Score file display 
Since this is a text editor, the display is reduced to the elements which matter in text manipulation. All 
elements to properly adjust text horizontally or vertically are present. Self-explanatory colors are used. 
Moving the mouse over an item reveals the details the user may need to know (font, actual SCORE 
encoding, parameters, width). 
In the above example, the blue background indicates a page number. Other elements are shown here: 
 

 
 
The grey background indicates a bar number. Dashes and the extender are drawn as rectangles, slightly 
oversized so they can be selected by the mouse for deletion. These lines appear off-center when the 
Autosize option in effect.  
On staff 6 there is a whole rest in blue.  
The selected display font is Arial Narrow which is a reasonable selection if the lyrics are not too close 
vertically. The disadvantage of this font is that the descenders are invisible. The four display selections are 
given here for comparison (Autosize not set): 
 

Small Fonts:  

 
MS Sans Serif: 

     
Arial Narrow: 

     
Haettenschweiler: 

     
 
When one wants to see notes and numbers for lyrics distribution, click a staff once. Here this is done on 
staff 6: 
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where it can be seen that numbers are assigned to notes (or chords rather). The notes themselves are also 
drawn for the duration of lyrics processing. 
Other display colors will be covered in the paragraphs which describe editing. 

4.3.4. Screen representation 
The representation of characters on the screen is only as good as Windows allows. When for instance the 
Cyrillic TimeScore character � with acute accent is encountered, it will be shown without the accent as 
Windows does not have that combination. 

4.4. Text control 
There are many controls in this frame which is visible when the user can input and update text. Most of the 
controls correspond to keys of the physical keyboard and they do not require any explanation. The reason 
for providing the drawn and mouse clickable keyboard is that for some scripts other than Latin such as 
Cyrillic, there is not always a physical keyboard at hand. The number of keyboard layouts in the world is 
impressive and SipText has the built-in flexibility to cater for any requirement. The first versions support a 
limited number of keyboards as governed by demand. 

4.4.1. Standard Text control 
The ‘English US’ keyboard is drawn in the following sample of the Text control frame: 
 

 
 
The keyboard has the common keys and on the right the ‘keys’ for the special SCORE characters for which 
the Windows font used for the keys has graphics (black characters) or not (red characters). When the mouse 
moves over a red foreground character key, the graphic is displayed in a large rectangle: 
 

 
 
The top status fields are filled when the mouse cursor moves over a text item or when an item is selected. 
The field shown here as having _00 is the font prefix field and has the font number of the text item 
currently being processed. Click this field to select a different font. The list of available fonts is given by 
number and name. The long white field is the input or keyboard buffer. Characters appear in this buffer 
while they are typed on the keyboard or clicked on the screen keyboard. Also, when an item is selected 
from the displayed page, it is moved to the input buffer. 
Keys with a colored background have a special meaning as explained by the Help > Color codes menu and 
shown here: 
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4.4.2. Full Text control 
The screen needs to be wider than 800 for the right part of the full keyboard to be shown. Note that the size 
of the frame is also enlarged vertically because it shows two additional buffers. The disadvantage of this of 
course is that the Page control frame reduces in size. 
Additional buffers show the text item in Windows encoding and in SCORE encoding. When a Cyrillic 
keyboard is active, one more buffer shows the transliteration of text items being processed. 

4.4.3. Control keys 
Outside the keyboard frame are the control keys Esc, CapsLock, Insert, Home, End, Del, Backspace, 
horizontal arrows and Enter. These correspond to the physical keyboard keys. Their function is explained 
hereafter. Note that the Alt key is reserved for its Windows function as letter shortcuts to menus, and to 
terminate with F4. 
When updating characters which can only be represented in Windows as SCORE diads or triads such as 
TimeScore <<y, then be careful editing them. When you want to change this character in the TimeScore 
string a<<ya then you need to delete three characters, then push insert, and then select any character form 
the physical or the screen keyboard. If you would just replace the ‘y’ by typing a character, SipText does 
not know that it is part of a triad and converts it incorrectly. 

Esc 
The Esc key clears the input buffer and sets CapsLock to lowercase. 

CapsLock 
This key selects the equivalent current keyboard in the uppercase setting. When set, the caption becomes 
bold. Optionally, the key caps can be shown in bold as shown here: 
 

 
 
A shift character can be input when the drawn keyboard is in lowercase. The Shift is only active on 
physical keyboard letters.  

Insert 
Characters typed are inserted at the cursor location, those on the right of the cursor shifting to the right. The 
cursor does not move. When Insert is not active, typed characters overwrite text at the cursor position. 
When active, the caption is bold. 

Home 
The cursor is moved to the extreme left of the text, in front of the first character. This is a way to see text 
which has shifted out on the left. 

End 
The cursor is moved to the extreme right of the text. When beyond the end of the visible part of the buffer, 
the text will be shifted in. 

Del 
The Del key deletes the character at the cursor. 

Backspace 
The Backspace key removes the character left of the cursor. 

Horizontal arrows 
These displace the cursor within the text. 

Enter 
This terminates input of a text item. 
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4.4.4. Keyboard diads 
It can be time saving when the diacriticals are automatically handled on input. SipText has a provision for 
this. There is a default set for the most common diads (an example is :a for ä) such that by typing the diad, 
the program automatically generates the combination. The user may switch on this feature for input via the 
physical keyboard and/or via the screen. Also, diads may be added by the user and they may be removed. 
To maintain the diads and set the diad translation on or off, hit the ‘Keyboard diads’ button on the option 
panel. This gives rise to the following panel: 
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The ‘Add entry’ prompts for the two strings which define a new diad. There is no limit to the number of 
diads. Different diads may refer to the same resulting character. 
Note that there are three modes of keyboard input: 

append – the cursor is at the right of the text to receive a new character; 
overwrite – the cursor is not at the end of the text and a typed character will overwrite an existing one; 
insert – the cursor is not at the end of the text and a typed character will be inserted. 

The diad translation only works in append mode. 

4.4.5. The Icelandic switch 
There is an internal switch by this name which controls the capability to use Icelandic characters eth (ð, Ð) 
and thorn (þ, Þ). The switch is set when FONTINIT.PSC contains the definitions for these characters which 
are also used in Old English. 
 

Postscript name Graphic Decimal value Octal value Default 
eth ð 162 242 cent         ¢ 
Eth Ð 165 245 yen          ¥ 
thorn þ 168 250 florin       f 
Thorn Þ 166 246 currency  ¤  

 
The line to be included in FONTINIT.PSC is: 
 

8#242/eth  8#245/Eth  8#250/thorn  8#246/Thorn 
 

and when these definitions are present, the characters will appear in the drawn keyboard, sacrificing the 
defaults. 
To see the status of the switch, select menu Help > Environment. 

5. Text items 
When a text item is to be modified it needs to be selected. Selection can be either immediate or via a 
submenu. Immediate replacement is caused after selection by a left mouse click. A submenu with a couple 
of options can be obtained by selection with the right mouse click. 

5.1. Immediate update 
This is simply a left mouse click on the green background of the text item. Selection turns the background 
of the item from green to pink, the font and text are moved to the Text frame fields. The text in the input 
buffer gets a red foreground to indicate update mode. Press Enter and the selected item is replaced and it 
gets the green background again. Optionally the font can be redefined before replacing the string. 

5.2. Update via submenu 
The submenu looks like this after selection with the right mouse click: 

 
The submenu rolls out right under the selected item (or if space requires, it is offset near the item). Most 
commands are self-explanatory.  
Edit ParN allows update of parameters 2 to 11. Note that changing Par2, the size of the item is affected 
when the new staff has a different size. 
Horizontal align moves the text to the nearest multiple of the horizontal step (default 1).  
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When updated, the background of the selected item returns to green and the submenu disappears. 
The move, join and split commands are described separately, hereafter. 

5.3. Moving text items 
A strong feature of SipText is its capability to move text. To move a text item it can be selected in two 
ways. Above we have seen the submenu from which the Move command can be selected. A shortcut to the 
same Move command is to select the item with a right mouse click while keeping the Shift key pressed. 
The effect of the Move command is that the background changes to sea-blue. Then drag the text item to the 
desired spot and drop it. To assign a staff number to the text item drag it over the intended drawn staff. 
Note that the size of the item is immediately influenced by the receiving staff size. 
When you want to move a text such as espressivo to a specific note, you can show all notes on a staff as a 
visual help by clicking the right mouse button on the desired staff. Right-click again on any staff to make 
the notes disappear. 

5.4. Join 
When two adjacent text items have the same vertical position and are of the same size, they can be 
combined into one text item. Select the left item, then give the join command. Note that horizontal distance 
is not significant. When separated by a dash or extender, syllables cannot be joined. The join can be used 
when texts horizontally overlap or to undo kerning on two items. 

5.5. Split 
When a text item needs to be split into two items, select the item, move the separator character where you 
want to separate and perform the split command. The separator character is defined as an option. The 
default is an asterisk. 

5.6. Creating text items 
Whenever the Text control frame is visible, text can be input to create new text items. By pressing the Enter 
key, the item is moved to the top left corner of the display page as a move item. It is assigned to the top 
staff. Drag it over the desired staff to assign Par2 before dropping it. 

6. Lyrics 
Input, update, and alignment of lyrics works as in SCORE but a number of additional features make the 
manipulation of lyrics easier and faster. Before working with lyrics, the user has to assure three things: 
� the size of the lyrics text must be defined as a global setting (‘set project options’); 
� the dash size must be defined in PREF.SCR (if not, the default size of 1.29 is used); 
� the space between verses must be defined as a local setting in the Options panel. When set to 4, the first 

verse will be at Par4 = -4, the second at Par4 = -8, etc.). When there is already a verse in a file at Par4 = 
-5, with a setting of 4, the next will be put at -9. 

6.1. Entering lyrics 
Before entering lyrics text, select the staff by clicking on it, then enter text with SCORE separators / (end of 
syllable1), !! (dash), and ?? (extender2). The selection of the staff shows the notes with their labels. As an 
example we enter the lyrics for the Beethoven song ‘An die ferne Geliebte’. 

  
We enter some of the text: 
 

 
 
After typing these eight syllables (note the graphic representation of umlaut characters), the Enter will 
cause the following to appear: 
 

                                                           
1 Since the slash is not in the Cyrillic ScoreCyr font, the character @ may be used interchangeably. 
2 In ScoreCyr, the ?? appear as ## on the screen, though ?? needs to be typed.. 
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which gives the syllable to be assigned and the first available note. To assign this syllable, click ‘This’ or 
the numbered label of your choice, or let SipText assign all remaining syllables across the notes that follow 
(the ‘99’ feature of SCORE). With ‘Advance’, the submenu moves to the next available note. To terminate 
assigning syllables before they run out, select ‘Stop’. Dashes and extenders will be properly placed. 
There is one difference with SCORE: you can specify empty syllables such as aaa///bbb and this will have 
the effect of repetitive ‘Advance’. 
When the second half of the lyrics line is entered, SipText knows that the first was not complete and lets the 
user continue, or if he wants, assign the second verse. 
Any invalid action will be properly signaled such as: 
 

 
 
When you entered lyrics but forgot to select the staff to get labels and notes, the text is put in the top left 
corner as one item. Move it somewhere, select it again, then select the staff and hit Enter again. 

6.2. Updating lyrics 
Individual syllables can be updated as text items, but it is possible to update an entire lyrics line. 
After selecting the lyrics staff, click a second time on the staff and another submenu will roll out: 

 
 

The ‘Edit’ choice moves the entire line to the input buffer with separators inserted for update. Pressing 
Enter replaces the line as if it were newly entered. 

6.3. Other lyrics functions 
As can be seen in the above submenu, there is the possibility to delete an entire lyrics line at once, 
including dashes and extenders. 
Moving up and down of entire lyrics lines is per vertical step as defined with the main menu Edit > Vertical 
step. 
The main menu’s Lyrics offers to align or center all syllables in a file to the nearest note. You can also 
center all dashes and align all extenders in one go. 
To remove individual dashes or extenders, select them with the mouse, then confirm the delete. 
When selecting a text item with the right mouse button, the submenu as shown in 5.2 rolls out. When the 
text is potentially a syllable (lyrics size and below the staff) the submenu has three more options: Dash 
right, Dash left and Extender for inclusion of these. 

7. Kerning 
Kerning refers to data included in a font that specifies how to adjust the spacing of a specific pair of 
characters in a font. The following example illustrates a word that uses kerning, and one with no kerning, 
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using the default spacing in the font. This example shows pair contraction but in some pairs, extra space is 
inserted. 

 
For kerning to be supported, the extension needs to be licensed. The environmental prerequisite for SipText 
to support kerning is that the Adobe Font Metrics (AFM) files for the kernable fonts are supplied. The 
kerning and unkerning features for SipText are herewith explained. 
Only horizontal items can be kerned. The spacing factor Code16Par5 is not considered. 
Text items with in-text font prefixes are allowed by the kerning process. 
SipText combines the capabilities of kerning with centering and alignment. It is at this point that a design 
limitation in SCORE turns out to be significant: SCORE allows centering and alignment (CT, JR), but it 
does not link such attributes to items. Every word processor remembers that a text is centered but there is 
no provision for this in SCORE and the parameter structure does not allow user attributes. Whenever a staff 
is rearranged, centered or aligned items belonging to such staff need to be centered and aligned again. For 
this reason, kerning is the last thing you want to do on a SCORE file. It would be so nice if SCORE 
remembered editing attributes and to have a visible indicator such as in Word to show alignment attributes 
by just pointing to a text item. Some of this is overcome in SipText but this is not an ideal world.   
There are commands for individual kerning and for a set of selected files. Those commands on a set of files 
are controlled by options (see 4.1.7). 
An effect of kerning is that because the display font is usually smaller than the actual character width, the 
result appears cut up. Autosize is set as to avoid backgrounds overlaps of text items. An example follows. 
 
Before: 

 
 
After: 

 
 
SCORE result: 
 

WATER MUSIC

 
 
The following demonstration shows various kerning/alignment capabilities as well as both unkerned and 
kerned text in a SCORE file. The font is Times-Roman. 
 

Left aligned text item AVAVAV

AVAVAVAVAVAV

AVAVAVAVAVAVAVA

Right aligned text item AVAVAV

Left aligned text item AVAVAV

AVAVAVAVAVAV
AVAVAVAVAVAVAVA

Right aligned text item AVAVAV
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7.1. Current item: kern to its center 
The selected item is kerned and the left end of the text is arranged such that the center of the resulting text 
is the same as the center of the original string. 

7.2. Current item: kern to its Par3 
The selected item is kerned keeping the original left position. 

7.3. Current item: kern to center 
The selected item is kerned to the center value (default 100). 

7.4. Current item: kern and flush right 
The selected item is kerned and justified to the right (default 200). 

7.5. Current item: kern and flush left 
The selected item is kerned and justified to the left (default 0). 

7.6. Current item: unkern with items on right 
Adjacent text items resulting from an earlier kern are combined into one item. Note the difference between 
‘Join’ and ‘Unkern’. Joining is on two equally horizontal items with any distance in between. The ‘Unkern’ 
should be given on the leftmost item to (re)combine all items on the right which are sufficiently close. 

7.7. Kern selected file(s) 
From the Kerning menu, select ‘Kern selected file(s)’. The program checks if files were selected and if the 
proper AFM files are available. Then it takes each text item and looks if it can be kerned. If so, it cuts up 
the text item into multiple text items with the Par3 to reflect the correct position. Options control how the 
result is aligned. Alignment options are: 
� Left alignment – the Par3 of the original item is maintained 
� Center alignment – the center of the original item is maintained 
� Setting alignment – when the end of the text is at the right flush position (default 200) it will right align. 

Any other situation will align to the leftmost position of the original item.  
With the kerning feature, when an item is selected, an additional option rolls out: ‘Kern (on)’ or ‘Kern 
(off)’. By default, all text items are ‘on’ but the user may select to make an item unkernable by setting it 
‘off’. The ‘off’ status is kept in the text item by setting Code16Par9 to 360 (In fact, this is a SipText 
attribute in the SCORE rotation parameter without SCORE ‘knowing’ this). After a kern run, the first 
selected result file is shown.  

7.8. Unkern selected file(s) 
Once you have kerned but an item needs to be moved or deleted, it is not handy to address the individual 
chunks of a text. Therefore, SipText has the Unkern command which does the inverse. However, there is no 
way to know what the original Par3 was before kerning, so the leftmost text chunk defines the new Par3. 
Unkerning only happens on adjacent items which have the same Par2, Par4, Par6 and the same font. 
This feature does not refer to AFM files. Following an unkern run, the first selected result file is shown. 
Autosize is reset by this command. Note that the ‘Unkern selected file(s)’ command is available without the 
kerning extension.  

8. Cyrillic 
For Cyrillic to be supported, the extension needs to be licensed. Everything which is possible in SipText 
with Latin script is also possible with Cyrillic. With the Cyrillic extension there are extra features 
documented here. 
SipText itself only uses Windows Cyrillic fonts which can be freely obtained from the Internet. The 
supported Cyrillic fonts used by SCORE are TimeScore and ScoreCyr. 

8.1. Cyrillic Windows fonts 
To view the contents of music with Cyrillic text and keycaps, Windows requires two Cyrillic fonts which 
can be downloaded from Fingertip Software3. These fonts are Couriere Cyr and Timesse Cyr. Optionally, 
the program can also use the fonts Bulgarian Ariel and ER Univers 1251. 
Installation of the required fonts must be done prior to installation of SipText. These modern Russian 
alphabets are shown here with an actual screen sample (Autosize set): 
 

                                                           
3 Fingertip Software, Universal City, TX at www.cyrillic.com. Download the evaluation copy which 
remains valid for 45 days. You do not need this program, just the fonts. The fonts remain available once the 
evaluation period expires. The current name of this package is Cyrillic Starter Kit 5.0. 
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Couriere Cyr 
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Timesse Cyr 
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Bulgarian Ariel  
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ER Univers 1251 
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To see which Windows font is selected for keycaps, point to the space bar and a tooltip gives two font 
names: the intentioned and the actual font name. This is a way to check that the Windows fonts was 
properly installed and activated (which is done after a cold start in Windows98. When not shutdown and 
restarted after installing Windows fonts, the Cyrillic keyboard on the screen will show Latin accented 
letters). 
 
The filenames of the Cyrillic Windows fonts are: 

BUARIL.TTF Bulgarian Ariel 
UN1251N.TTF ER Univers 1251 
FSCOUCY.TTF Couriere Cyr 
FCTIMCY.TTF Timesse Cyr 

Note that the latter two fonts are mandatory for SipText with the Cyrillic extension. These files are on the 
delivery medium (folder FontsWindows).  Check font installation by looking at the Insert > Symbol panel 
in Word after selecting the fonts. There should not appear squares in stead of Cyrillic characters. When 
there are squares, installation failed. In that case erase the TTF's, then download and install the Cyrillic 
Starter Kit from Fingertip Software.  

8.2. Cyrillic Score fonts and keyboards 
The user must decide which SCORE font to use. Currently there are the fonts TimeScore, made available 
by Sergei Lebedev and  ScoreCyr, used by Matanya Ophee. SipText works with both fonts. TimeScore 
consists of a family with bold, italic, and bold-italic variants. The TimeScore family is documented in the 
article The Cyrillic TimeScore family of fonts at www.dekloe.be and on the installation medium. 
The SCORE fonts need to be assigned a font number of choice. Since fonts are selected by name it does not 
matter to SipText which numbers are assigned. 
In theory, any supported Cyrillic keyboard works with any of these Cyrillic SCORE fonts though practice 
dictates otherwise: work with either TimeScore and keyboard Russian Lebedev or ScoreCyr and keyboard 
Russian Standard. It is however perfectly possible to mix the Cyrillic SCORE fonts in one file, or even in 
one text item. 

8.2.1. TimeScore 
This family of fonts is usually input with a Latin keyboard and the keys are based on phonetic or visual 
resemblance with the Latin alphabet.  
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Select the Russian Lebedev keyboard to be drawn and you can enter characters via the physical keyboard 
and the drawn keyboard. Shown here are the lowercase and uppercase keyboards: 
 

 
 

 
 
The red foreground keys represent characters which cannot be visualized by Windows but these are shown 
in a large rectangle when the mouse moves over the key. The red background keys indicate absence of the 
characters with octal values 333, 334, and 335 (breve, bullet, acute) in the selected TimeScore font 
(TimeScore-Bold). The purple key denotes that the character is existing in the font but it misses the 
appropriate adaptation in the FONTINIT.PSC file. See the article for details. 
The ‘\\’ button is provided to enter octal values. Note that the backslash as such does not exist as a one-
character encoding in TimeScore and you cannot enter the octal prefix via the physical keyboard. When 
followed by three octal digits, the \\ is kept ‘as is’. 

8.2.2. ScoreCyr 
This font is used with a Russian Standard keyboard. It is fully documented in the article The ScoreCyr 
Cyricllic font for use in Score at www.dekloe.be and on the installation medium. 
 

 
 
The drawn keyboard looks thus (lowercase and uppercase): 
 

 
 

 
 
As you see, some non-Russian Cyrillic characters are provided through this keyboard/font combination. 
The red background keys are characters missing from the font. To make those in a Latin font, set the option 
‘Allow Latin characters in Cyrillic’. Then the keyboard will look like this: 
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where the pink keys when used, automatically change the font prefix in the text for the duration of those 
Latin characters. Exercise extreme care updating strings with in-text font changes. 
The ‘\\’ button is provided to enter octal values. Note that the backslash as such does not exist as a one-
character encoding in ScoreCyr and you cannot enter the octal prefix via the physical keyboard. When 
followed by three octal digits, the \\ is kept ‘as is’. 

8.3. Other SIP utilities for Cyrillic 
The free utilities in the SIP collection which can come in handy when using Cyrillic fonts are: 
SipFind – find SCORE music files with a Cyrillic string of characters. The search string is to be pasted into 
the field (TimeScore family of fonts only). Case sensitive or insensitive, with or without ‘?’ wildcard(s), 
whole word or part, date range. 
SipAnlib – to quickly see which Cyrillic fonts exist in the SCORE environment with their font number. 
SipEdit – to change a particular font number in a range of files.  
See the applicable descriptions. 

9. Installation of SipText 
The software is delivered on a CD prepared for standard setup with Windows. In addition to the software 
there are various other files on the installation medium. Consult the README.TXT file for instructions 
that did not make it to the User Guide. 

9.1. Licensing 
A simple asset protection scheme is included. SCORE files have the license identification of the owner. 
SipText has the owner’s license number included at compile time and verifies that input files have this 
same identification, or the identification of the supplier as to allow sample files to be processed. Output 
files always have the owner’s identification. When a user reads a SCORE file with Cyrillic text but he does 
not have the Cyrillic extension license, then this file cannot be processed.  

9.2. AFM files 
Adobe Font Metrics files exist for the ‘basic 35’ fonts. In principle, the standard PSC files have information 
obtained from AFM files but experience from various SCORE users indicates that at least the currently 
available AFM files show differences with the PSC files that come with SCORE. 
AFM information is used to compute the width of text in centering, flushing, and placement of lyrics, 
dashes and extenders. 
SCORE only obtains metrics information from its PSC files. SipText however will first see if the relevant 
AFM information is present and use it as it seems to be more complete and accurate than the default PSC 
files. Only when no AFM file is present for a font, will SipText establish metrics from PSC’s. 
When kerning is used, the presence of AFM files is mandatory since these define kerning pairs. To see that 
the files are indeed installed, click the font prefix field in the Text control frame: 
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Close the list by clicking in it. 

9.3. Documentation 
The current document is copied to the delivery CD, as well as the articles The Cyrillic TimeScore family of 
fonts and The ScoreCyr Cyrillic font for use in Score in both Word and PDF format. 

9.4. Demonstration files 
The following files may be used to test the functionality: 
SIPIVP01.MUS and SIPIVP02.MUS these come with every SIP delivery 
00OCTAL.MUS    octal values 000-377 in Times-Roman 
49OCTAL.MUS    octal values 000-377 in ScoreCyr 
50OCTAL.MUS    octal values 000-377 in TimeScore 
49CYRTST.MUS   full character set in ScoreCyr 
50CYRTST.MUS   full character set in TimeScore (contains fonts 50-54) 
To use the latter four files, the user needs to equate the font prefix number to his font assignment. Only the 
IVP (Installation Verification Procedure) files are automatically moved to the SIP directory by the 
installation procedure (SIPIVP01.MUS and SIPIVP02.MUS). The others may be copied from the delivery 
medium. 

9.5. Loading fonts to the printer 
Fonts not belonging to the ‘basic 35’ set need to be loaded to the printer with common tools. This is outside 
the functionality of SIP. 

9.6. Bitmaps 
Like SCORE, SipText has a library of symbols. These symbols are used to visualize those characters that 
do not have a Windows equivalent in a common font. 
After installation of SIP, the folder SipBitMaps needs to be created and the bitmaps from the installation 
medium have to be moved there. When at execution, SipText does not find these bitmaps it will provide  
the name of the path where it expects these. 
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9.7. Installation sequence 
� Optional when you want to use AFM for the basic 35 fonts and/or your own fonts, mandatory when 

kerning is used: Create a folder with these fonts. The basic 35 are on the delivery medium (zipped, 
folder FontsScore). 

� Install SIP with the standard setup. 
� Create the SipBitMaps folder. Execution of SipText will tell you where. Move the bitmaps from the 

delivery medium to this folder. 
� Assure that you have the Cyrillic PSC file(s) in the SCORE library. 
� These are included (assigned to 49 for ScoreCyr and 50-54 for TimeScore) on the delivery medium 

(folder FontsScore). 
� If you want to use these and the demo files, assure that the font numbers match. 
� Install the Cyrillic Windows fonts Couriere Cyr and Timesse Cyr. 

10. Current restrictions 
The following is a summary of known restrictions which may be lifted in a future version of SipText: 
� the character %%Y cannot be selected as a graphic character; 
� built-in fonts 90-94 and those above are not supported; 
� Outline font is not completely implemented; 
� An Undo function is not implemented; 
� CODE9.DAT text is not considered; 
� Capability to work with character sizes in points independent from staff size remains to be 

implemented. 
The realization of extensions is controlled by demand and capability. 

11. The Profile 
There is no need to set parameters in the profile file SIPTEXT.PRO through a text editor as all entries are 
controlled by the graphical interface. The following is a sample profile: 
 
* SipText profile - generated 03-17-2004 at 13:57:54 
* v1.00 - build 006 
* Part 1 
Keyboard=English US 
AllowUnderscore=0 
AmpersandReplacement=undefined 
OutlineFont=False 
FullKeyboardPanel=False 
AllowLatinInCyrillic=0 
InsertLatinFont=_00 
UppercaseAsBold=False 
PreferedKeyboardLatin=English US 
PreferedKeyboardCyrillic=Russian Lebedev 
PreferedKeyboardGreek=undefined 
PreferedKeyboardHebrew=undefined 
PreferedKeyboardArabic=undefined 
PreferedScreenLatin=Small Fonts 
PreferedScreenCyrillic=Couriere Cyr 
PreferedScreenGreek=undefined 
PreferedScreenHebrew=undefined 
PreferedScreenArabic=undefined 
InputBufferSize=large 
VerticalLyricsSpace=4 
* Part 2 
VisualBeep=500 
GreaterInTimeScore=False 
BreveInTimeScore=False 
BulletInTimeScore=False 
AcuteInTimeScore=False 
BreveInTimeScoreBold=False 
BulletInTimeScoreBold=False 
AcuteInTimeScoreBold=False 
* Part 3 
HorizontalEditAlignment=1 
VerticalEditAlignment=1 
ValueCenter=100 



 24

ValueLeftFlush=0 
ValueRiteFlush=200 
Autosize=False 
Ruler=True 
TimeScorePreferenceIO3=True 
TimeScorePreferenceIO1=False 
SuppressMissingWindowsFontsMessage=0 
KernAlignLeft=True 
KernAlignCenter=False 
KernAlignSetting=False 
SplitSeparator=* 
ExtenderNoteEnd=3 
ExtenderStaffEnd=-2 
DashLeftSpace=4 
VerticalDashOffset=-0.8 
VerticalExtenderOffset=0 
BigTooltip=True 
ActivateDiadTranslationK=0 
ActivateDiadTranslationS=1 
PageOnSideDisplacement=3 

12. Change history 
 
Version nature of change date 
1.05 Finnish keyboard, keyboard diads, screen size to help, big tooltip March 13, 2004 
1.06 Page number center/align March 17, 2004 
   
 


